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Chapter 138

Superiority by a
Margin Tests for the
Ratio of Two
Variances
Introduction
This procedure calculates power and sample size of superiority by a margin tests of (total = between + within)
variances from a two-group, parallel design. This routine deals with the case in which the statistical hypotheses are
expressed in terms of the ratio of the variances.

Technical Details
This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 217 - 220.
Suppose 𝑥𝑥𝑖𝑖𝑖𝑖 is the response of the ith group (i = 1, 2) and jth subject (j = 1, …, Ni). The model analyzed in this
procedure is
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 = 𝜇𝜇𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖

where 𝜇𝜇𝑖𝑖 is the treatment effect and 𝑒𝑒𝑖𝑖𝑖𝑖 is the between-subject error term which is normally distributed with mean 0
2
. Unbiased estimators of these variances are given by
and variance 𝑉𝑉𝑖𝑖 = 𝜎𝜎𝐵𝐵𝐵𝐵
𝑁𝑁𝑖𝑖

1
2
��𝑥𝑥𝑖𝑖𝑖𝑖 − 𝑥𝑥̅𝑖𝑖 �
𝑉𝑉�𝑖𝑖 =
𝑁𝑁𝑖𝑖 − 1
𝑗𝑗=1

𝑁𝑁𝑖𝑖

1
𝑥𝑥̅𝑖𝑖 = � 𝑥𝑥𝑖𝑖𝑖𝑖
𝑁𝑁𝑖𝑖
𝑗𝑗=1

A common test statistic to compare variabilities in the two groups is 𝑇𝑇 = 𝑉𝑉�1 /𝑉𝑉�2. Under the usual normality
assumptions, T is distributed as an F distribution with degrees of freedom 𝑁𝑁1 − 1 and 𝑁𝑁2 − 1.
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Testing Superiority by a Margin
The following hypotheses are usually used to test for superiority by a margin
𝐻𝐻0 : 𝜎𝜎12 /𝜎𝜎22 ≥ 𝑅𝑅0 versus 𝐻𝐻1 : 𝜎𝜎12 /𝜎𝜎22 < 𝑅𝑅0 < 1,

where R0 is the superiority by a margin limit.

The corresponding test statistic is 𝑇𝑇 = (𝑉𝑉�1 /𝑉𝑉�2 )/𝑅𝑅0 .

Power

The power of this combination of tests is given by
𝑅𝑅0
� 𝐹𝐹
(𝑀𝑀−1),𝑁𝑁2 (𝑀𝑀−1) �
𝑅𝑅1 𝛼𝛼,𝑁𝑁1
where F is the common F distribution with the indicated degrees of freedom, 𝛼𝛼 is the significance level, and R1 is
the value of the variance ratio stated by the alternative hypothesis. Lower quantiles of F are used in the equation.
Power = P �𝐹𝐹 < �

A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary
sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis when in
fact it is true.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
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N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size
R0 (Superiority Variance Ratio)
Enter one or more values for the superiority by a margin limit for the ratio of the two variances. When the ratio of
the sample variances is less than this value, the treatment group (group 1) is concluded to be “superior” to the
reference (group 2) group (since it has a smaller variance).
This value must be less than one. Popular choices are 0.5 and 0.75.
R1 (Alternative Variance Ratio)
Enter one or more values for variance ratio assumed by the alternative hypothesis. This is the value of 𝜎𝜎12 /𝜎𝜎22 at
which the power is calculated.
This value should be less than R0.
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Example 1 – Finding Sample Size
A company has developed a generic drug for treating rheumatism and wants to show that it is superior (has a
smaller variance) to the standard drug. A parallel-group design will be used.
Company researchers set the superiority limit to 0.75, the significance level to 0.05, the power to 0.90, , and the
actual variance ratio values between 0.2 and 0.6. They want to investigate the range of required sample size
values assuming that the two group sample sizes are equal.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Variances procedure window. You may
then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
R0 (Superiority Variance Ratio) .............. 0.75
R1 (Actual Variance Ratio) ..................... 0.2 0.3 0.4 0.5 0.6

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────

Actual
Power
0.9067
0.9021
0.9013
0.9009
0.9001

Group 1
Sample
Size
N1
22
43
89
211
690

Group 2
Sample
Size
N2
22
43
89
211
690

N
44
86
178
422
1380

Superiority
by a Margin
Variance
Ratio
R0
0.750
0.750
0.750
0.750
0.750

Actual
Variance
Ratio
R1
0.200
0.300
0.400
0.500
0.600

Alpha
0.050
0.050
0.050
0.050
0.050

References
Johnson, N.L., Kotz, S., and Balakrishnan, N. 1995. Continuous Univariate Distributions, Volume 2, Second
Edition. John Wiley & Sons. Hoboken, New Jersey.
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Taylor & Francis/CRC. Boca Raton, Florida.
Chow, S.C. and Liu, J.P. 2014. Design and Analysis of Clinical Trials, Third Edition. John Wiley & Sons.
Hoboken, New Jersey.
Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly
larger than the target power.
N1 is the number of subjects from group 1. Each subject is measured M times.
N2 is the number of subjects from group 2. Each subject is measured M times.
N is the total number of subjects. N = N1 + N2.
R0 is the superiority-by-a-margin limit for the variance ratio.
R1 is the value of the variance ratio at which the power is calculated.
Alpha is the probability of rejecting a true null hypothesis, H0.
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Summary Statements ─────────────────────────────────────────────────────────
A study is being conducted to assess the superiority of the variance of a treatment group over
the control group. If the sample variance ratio falls below the superiority limit, the
treatment group is concluded to be superior (has a smaller variance) to the control group.
Otherwise, it is not. Group sample sizes of 22 and 22 achieve 91% power to reject the null
hypothesis of non-superiority at a significance level of 0.050. The superiority limit is 0.750.
The variance ratio at which the power is calculated is assumed to be 0.200.

This report gives the sample sizes for the indicated scenarios.

Plot Section

These plots show the relationship between sample size and R1.
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Example 2 – Validation using Hand Calculations
We could not find an example in the literature, so we will present hand calculations to validate this procedure.
Set N1 to 266, the superiority limit to 0.75, the significance level to 0.05 and the actual variance ratio value 0.5.
Compute the power.
The calculations proceed as follows.
𝑅𝑅0
Power = P �𝐹𝐹 < � � 𝐹𝐹𝛼𝛼,𝑁𝑁1 −1,𝑁𝑁2 −1 �
𝑅𝑅1

= P �𝐹𝐹 < (0.75/0.5) �𝐹𝐹0.05,265,265 ��

= P�𝐹𝐹 < 1.5(0.81672883)�
= P(𝐹𝐹 < 1.22509325)
= 0.95047403

Hence, the power is 0.9505 to four decimal places.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Variances procedure window. You may
then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 266
R0 (Superiority Variance Ratio) .............. 0.75
R1 (Actual Variance Ratio) ..................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Group 1
Sample
Size
Power
N1
0.9505
266

Group 2
Sample
Size
N2
266

N
532

Superiority
by a Margin
Variance
Ratio
R0
0.750

Actual
Variance
Ratio
R1
0.500

Alpha
0.050

The power matches the value calculated by hand.
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